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This documentation contains general descriptions and/or technical characteristics of the 
performance of the products contained herein. It is not intended to determine the suitability or 
reliability of these products for any particular user application. It is the obligation of each user or 
integrator to perform the appropriate and complete risk analysis, evaluation and testing of the 
products with respect to each specific application or use. Neither AZ-Delivery Vertriebs GmbH nor its 
affiliates or subsidiaries are responsible or liable for any misuse of the information contained herein. 
If you have any suggestions for improvements or changes, or have found errors in this publication, 
please let us know.

All relevant national, regional and local safety regulations must be observed when installing and 
using this product. For safety reasons and to ensure compliance with the documented system data, 
only the manufacturer may carry out repairs to components.

Failure to observe these instructions may result in injury or damage to property.

Copyright and Copyright
Copyright © 2018-2019 AZ-Delivery Vertriebs GmbH

All rights reserved. No part of this publication may be reproduced, distributed or transmitted in any 
form or by any means, including photocopying, recording or any other electronic or mechanical 
process, without the prior written permission of the publisher. For authorisation requests, please 
contact the publisher, marked " For: Authorisation Coordinator", at the address below.

AZ-Delivery Vertriebs GmbH, Bräugasse 9, 94469 Deggendorf 
Web: www.az-delivery.de

http://www.az-delivery.de/
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Trademark

AZ-Delivery Vertriebs GmbH has made every effort to provide trademark information on the 
company names, products and services mentioned in this manual. The trade marks shown below 
originate from various sources. All trademarks are the property of their respective owners.

General notes: Some product names used in this manual are used for identification purposes only 
and may be trademarks of their respective companies.

Product changes

Year Version Modifications
V1.0.0 -

Versions of this documentation

date Version Changes
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1. Foreword
1.1. Description of the target group

These instructions are intended for hardware and software developers with 
expertise in the field of electrical engineering and for original equipment 
manufacturers (OEMs).

1.2. Conventions used in this manual
The following formatting is used in this document:

Bold print

Names of product elements, commands, options, programs, processes, 
services and utilities Names of interface elements (e.g. windows, dialogue 
boxes, buttons, fields and menus)

Interface elements that the user selects, clicks, presses or types

Italics

Publication title referred to in the text Focus (e.g. a new 
term)
Variables

Courier

System output, e.g. error message or script
URLs, complete paths, file names, prompts and syntax
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DANGER

WARNING

CAUTION

1.3. Explanation of the safety instructions

The following warnings are used in these operating instructions:

Personal injury:

DANGER indicates an imminent danger. If it is not avoided, death or serious injury will 
result.

WARNING indicates a potentially imminent danger. If it is not avoided, death or serious 
injury may result.

CAUTION indicates a potentially imminent danger. If it is not avoided, slight or minor 
injuries may result.

Product/machine/equipment damage (ANSI Z535 only):

 NOTE 
NOTICE indicates a potentially harmful situation. If it is not avoided, the system or 
something in its vicinity may be damaged.
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1.4. Storage instructions
Read and observe this manual and the safety instructions it contains before using 
this product. Failure to do so may result in damage to the product.
Follow all instructions. This will prevent fire, explosions, electric shocks or other 
hazards that could lead to property damage or personal injury.
The product may only be used by persons who have fully read and understood the 
contents of these operating instructions.
Ensure that every person using the product has read and followed these warnings 
and instructions.
Keep all safety information and instructions for future reference and pass them on to 
subsequent users of the product. The manufacturer is not liable for damage to 
property or personal injury c a u s e d  by improper handling or failure to observe the 
safety instructions. In such cases, the warranty is void.
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1.5. Procurement of documents and information
1.5.1. Internet

The latest version of the documentation is available at the following address:
www.az-delivery.de

1.5.2. Other languages

This is the operating manual in German. Manuals in other languages will be 
provided on request if available.

1.5.3. Feedback on the documentation

Comments on AZ-Delivery documentation can be sent by e-mail to the 
following address: redaktion@az-delivery.com

We welcome your comments.

1.5.4. Support and customer service

For further questions, information, technical support or to order operating 
instructions, please contact the manufacturer:

AZ-Delivery Vertriebs GmbH 
Bräugasse 9
94469 Deggendorf 

info@az-delivery.com

http://www.az-delivery.de/
mailto:redaktion@az-delivery.com
mailto:info@az-delivery.com
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2. Description of the product
2.1. Intended use

The AZ-Delivery D1 mini V4 was developed as a test module or prototyping platform 
for learning the programming of microcontrollers. Any other use beyond this is not 
intended. Never use the module for safety-relevant applications.

The AZ-Delivery D1 mini V4 may only be used with the following software, original 
accessories and components:

● Espressif SDK
● Arduino core
● USB-C cable, USB2.0 certified

2.2. Product description
The AZ-Delivery D1 mini V4 is a so-called "physical computing platform" similar to 
the modules of the well-known Arduino family. The module essentially consists of 
two components, a USB-to-serial converter (CH340) and a microcontroller with a 
highly integrated TCP/IP stack (ESP8266). The module also has a micro USB socket 
for power supply and as a programming interface, a controllable LED and a fixed 
voltage regulator.

2.3. Scope of delivery

● 1x AZ-Delivery D1 mini V4 WiFi board
● 2x socket strip 8-pin short
● 2x socket strip 8-pin long
● 2x pin header 8-pin
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2.4. Dimensions

fig. 2.4.1 - AZ-Delivery - D1 mini - Dimensions in mm

fig. 2.4.2 - AZ-Delivery - D1 mini - Dimensions in mm
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2.5. Technical data

Technical data
Device name AZ-Delivery D1 mini V4

Model V4

Processor ESP8266EX

Logic level 3.3V

Power supply
Supply via USB interface: 5.1V

Supply via input pins: 3.0V - 3.6V

Max. Load capacity of the

GPIO pins
10mA each, max. 50mA total

Energy consumption Depending on the operating mode, up to a maximum of 500mA 
(peak)

Frequency range ISM band at 2.4Ghz: 2.412-2.472 GHz

Maximum transmission 
power

Up to 20 dBm (0.1W) (802.11b) @ 11Mbps 

Up to 19 dBm (0.08W) (802.11g)

Up to 19 dBm (0.08W) (802.11n)
Interfaces UART / GPIO / ADC / PWM / SPI / I2C

Max. Baud rate UART Up to 4608000 bps

I / O pins 11

USB interface CH340G, USB-C
Grid dimension 2.54 mm
Requirements for the

Operating environment
Exclusively indoor

Dimensions L = 34 mm, W = 26 mm, H = 8 mm

Weight 3g

I2C connection JST SH1.0 4 pin
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2.6. Requirements for the operating environment
Only operate the product in a clean, dry and dust-free environment. Never expose 
the product to water or moisture.

Please note that the processor generates heat during operation and ensure 
adequate ventilation to dissipate this heat.

Protect the module from conductive surfaces during operation to avoid short 
circuits.

2.7. Requirements for the power supply
A stabilised direct current source with appropriate protective devices is required to 
supply the module via the input pins.

Each voltage source must comply with the relevant national standards and 
regulations. Only use a fused, stable DC voltage source with 5V and at least 500mA 
nominal power.

For supplying the module via the USB interface:
Only use a power supply unit that complies with the USB specifications.
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2.8. Product elements

fig. 2.8.2 - AZ-Delivery - Di mini V4 - Top side

A. ESP8266EX
B. USB-C socket
C. Reset button
D. GPIOs
E. Wlan antenna

F. JST SH1.0 4pin I2C connection
G. CH340C
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2.9. Pinout Diagram

fig. 2.9.1 - AZ-Delivery - Di mini V4- Pinout Diagram
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3. Functionality
The AZ-Delivery D1 mini V4 was created from the requirement to make a WiFi development 
board with the simplest possible circuitry available to specialists on the European market at 
the lowest possible price. The module essentially consists of the following components:

3.1. ESP8266EX
The ESP processor integrates the Tensilica L106 ultra-low-power 32-bit 
microprocessor architecture in a small housing and clocks at 80 MHz and 160 MHz. It 
supports RTOS and integrates Wi-Fi MAC/BB/RF/PA/LNA functions.

The ESP8266EX WiFi module supports the IEEE802.11 b/g/n standard and 
implements the complete TCP/IP protocol stack. Users can use this module to add 
network functions to existing devices or create separate network controllers. The 
ESP8266EX is a powerful wireless SOC (SystemOnaChip) that offers maximum 
benefit at the lowest cost and almost unlimited possibilities for integrating WiFi 
functions into other systems.  The ESP8266EX is a complete and self-contained WiFi 
network solution that enables both host and client operation.

The ESP8266MOD is able to boot directly from the SPIFFS integrated in the module 
(external flash memory with SPI connection). The built-in cache helps to improve 
system performance and reduce memory requirements.

The ESP takes over the functionality of a WiFi adapter and can be added to any 
microcontroller-based design. Communication is straightforward via the SPI/SDIO, 
I2C or UART interfaces.

fig. 3.1.1 - ESP8266MOD 12-F - Functionality
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3.2. CH340
The CH340 IC is a widely used USB to serial converter with TTL and UART 
compatibility. It serves as an inexpensive and reliable programming interface and 
can be found in many IoT devices as well as in everyday hardware such as coffee 
machines, barcode scanners, children's toys or even vehicles.

fig 3.2.1 - CH340G - Mode of operation

3.3. Operating interface
The user interface depends on the programming environment used. Use with the 
Arduino IDE or Eclipse is possible. You can find installation instructions for the 
Arduino IDE in chapter 6.2.3.

3.4. Control panels
The AZ-Delivery D1 mini only offers a single button for operation. Pressing the 
button triggers a reset of the ESP8266EX by pulling pin 1 'RST' to 'LOW'.

3.5. Explanation of the visual signals
Visual signals can be output via an LED. This is connected to the GPIO2 pin of the 
ESP8266EX.
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CAUTION
4. Safety instructions

Read and understand this manual and its safety instructions before 
using this product. Failure to do so may result in damage to property.

4.1. Safety instructions for handling microcontrollers
When using electronic modules, a number of safety precautions must be observed 
to prevent injury, damage and interference with other devices. Therefore, please 
read these operating instructions and the safety instructions carefully before 
commissioning. Keep them in a safe place so that this information is available to you 
at all times. If you pass the module on to other persons, please hand over these 
operating instructions/safety instructions with it. We accept no liability for accidents 
or damage caused by non-compliance with these instructions and safety 
instructions.

4.1.1. General safety instructions
● Do not continue to use the module if it is damaged.
● When handling products that come into contact with electrical 

voltage, the applicable VDE regulations must be observed.
● In schools, training centres, hobby and self-help workshops, 

operation must be supervised by trained personnel.
● In commercial facilities, the accident prevention regulations of the 

German Federation of Industrial Employers' Liability Insurance 
Associations for electrical systems and equipment must be 
observed.

● Do not operate the product in an environment where flammable 
gases, vapours or dusts are present or may be present.

● The product must not be dropped or subjected to strong mechanical 
pressure, as it may be damaged by the impact.
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4.1.2. Safety instructions for handling electrostatic-sensitive components and 
groups

● In principle, microcontrollers are sensitive to electrostatic charges. 
When handling the module, make sure to dissipate electrostatic 
charges before touching the product to avoid damaging the module.

● Only remove the product from the anti-static packaging if you want 
to solder or programme the product.

4.1.3. Safety instructions for soldering the pin strips
● Check soldering equipment for proper condition before starting 

work, especially in the case of electric soldering equipment and 
damaged cables and cable entries.

● Use a safe, non-flammable surface. Keep the workplace free of 
highly flammable materials.

● The temperature of the hot soldering iron is over 300 °C. There is a 
risk of burns if handled incorrectly!

● Do not inhale soldering vapours! They are hazardous to health.
● Place the soldering iron in the holder immediately after soldering 

before proceeding with further work steps.
● Work calmly and with concentration!
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4.1.4. Explanation of the safety instructions on the packaging and the product

Symbol Meaning

The CE marking on the product is the 
manufacturer's declaration that the 
product the essential 
requirements of the relevant European 
health, safety and environmental 
protection legislation.

The symbol on the product, accessories or 
packaging indicates that this appliance 
must not be treated as unsorted 
municipal waste, but must be collected 
separately.

WEEE-Reg.-No.: DE 62624346
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5. Instructions for safe operation
● Do not make any changes to the hardware!
● Do not overclock the product!
● Only use the product with the software recommended by us.
● Only operate the module within the specifications stated by us
● Pay attention to the respective local conditions for the use of WiFi (e.g. petrol 

stations, hospitals).
● Avoid avoid the handling of the product with connected 

voltage source.
● The module was designed for operation at room temperature, do not expose it to 

any heat source after soldering.
● Avoid direct sunlight, as this can damage the circuit board in the long term.
● Only load the GPIOs within the specifications defined in the data sheet
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6. Commissioning
6.1. Soldering the pin or pin headers

When mounting, you have the option of using the pin headers. Alternatively, you 
can use the socket connectors with long pins or the socket connectors with short 
pins.

To prevent the pins from moving during the soldering process, it is recommended to 
place the pin headers in a breadboard as shown below.

The long side of the pins should sit downwards in the breadboard.

fig. 6.1.1 - Breadboard with pin headers

Place the D1 mini V4 module with the ESP8266EX chip facing upwards over the 
pin headers so that the short pins protrude through the openings provided.
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fig. 6.1.2 - Top side of a D1 Mini on pin headers (example)

During the soldering process, make sure that you create both a reliable mechanical 
and an electrically conductive connection.

fig 6.1.3 - The soldering process

When using the female headers (either with long or short pins), you can place the 
female header on the male headers in the breadboard to simplify positioning during 
the soldering process.
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fig 6.1.4 - Breadboard with pin headers on which the socket connectors have 
been placed

Now place the D1 mini V4 module over the socket strips and press the module 
completely down until it is flush. The pins should protrude as far as possible.
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fig 6.1.5 - Breadboard with pin headers, on which the socket connectors with 
long pins have been placed, with a D1 mini module
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fig. 6.1.6 - Breadboard with pin headers, on which the socket connectors with 
short pins have been placed, with a D1 mini module

Make sure that the D1 mini is flush before starting the soldering process.
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fig. 6.1.7 - The soldering process with socket connectors and long pins

6.2. Download and installation of the development environment
6.2.1. Obtaining the necessary software

Obtain the latest version of the following software packages:
● Driver for the USB interface CH340

http://www.wch.cn/download/CH341SER_ZIP.html

● Development environment and toolchain for Arduino-compatible boards
https://www.arduino.cc/en/Main/Software

http://www.wch.cn/download/CH341SER_ZIP.html
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6.2.2. Driver installation

The download of the file CH341SER.zip starts after clicking on the button 
marked blue in the picture.

fig. 6.2.2.1 - Download page for the CH340 driver

Then unzip the *.zip file into a directory of your choice and run the 
"Setup.exe" application. You can then install the drivers automatically 
by clicking on the button.

6.2.3. Installation of the development environment

Windows users should definitely use one of the first two download options 
for the Arduino IDE. The "Windows App" version from the Windows Store 
leads to connection problems, especially when u s i n g  third-party board 
definitions.
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fig. 6.2.3.1 - Download of the Arduino IDE with hint arrow for Windows users

After starting the Arduino IDE installation file "arduino-1.X.X-
windows.exe", the licence conditions of the software must be read and 
accepted.

fig. 6.2.3.2 - Arduino licence conditions

In the next step, various options can be selected for installation. can be 
selected.
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fig. 6.2.3.3 - Arduino options during installation

Option Explanation

Install Arduino 
software

Installs the Arduino IDE - This option cannot be deselected

Install USB Driver Installs USB drivers for various other microcontrollers. 
These are not required to use the software with the D1 
mini V4, but we strongly recommend installing them if you 
also use other microcontrollers

Create Start Menu 
shortcut

Creates a shortcut in the Windows Start menu (optional)

Create Desktop 
shortcut

Creates a shortcut on the workstation (optional)

Associate .ino files Creates a file name extension for files with the extension 
.ino and links them to the Arduino IDE

Finally, the destination folder must be specified. The installation requires approx. 
500MB of free disc space.
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fig. 6.2.3.4 - Arduino installation - destination folder

Click on "Install" to start the installation.

fig. 6.2.3.5 - Arduino installation - Installation procedure

After successful installation, the installation programme can be closed using 
the "Close" button.
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fig. 6.2.3.5 - Arduino installation successfully completed

6.3. Configuration of the Arduino IDE
Once the drivers and the development environment have been installed, the 
necessary board information and the toolchain for the ESP still need to be entered: 
To do this, start the development environment that has just been installed.

fig. 6.3.1 - Arduino IDE - The first start
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The D1 mini is not part of the standard repertoire of the Arduino IDE. Additional 
board definitions must therefore be installed via the board manager. In order for the 
board administrator to have access to the definitions, the board administrator URL 
must first be specified in the Arduino IDE default settings.

This setting can be found in the "File" -> "Preferences" menu. The following URL 
must be entered in the "Additional board administrator URLs:" input field:

http://arduino.esp8266.com/stable/package_esp8266com_ind 
ex.json

fig. 6.3.2 - Arduino IDE - "File" -> "Preferences" -> "Additional board manager URLs"

Confirm the entry by clicking on the "OK" button.
The corresponding board definitions are downloaded and installed in the board 
manager of the Arduino IDE. You can access the corresponding dialogue via the 
"Tools" -> "Board:" -> "Board manager  " menu.
As soon as "8266" is entered in the search field, the package "esp8266 by ESP8266 
Community" appears. By clicking on the "Install" button, the required components 
are downloaded and are immediately available within the Arduino IDE.

http://arduino.esp8266.com/stable/package_esp8266com_ind
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fig. 6.3.3 - Arduino IDE - "Tools" -> "Board:" -> "Board manager..." -> "8266"

6.4. Commissioning the WiFi board
After mounting the module and installing the software, you can connect the module 
to your PC. If a new USB device is recognised, you will hear the typical signal tone in 
Windows. To check whether the module is recognised correctly and the driver 
installation was successful, the interface can be displayed in the device manager.
The easiest way to open the device manager is to use the WIN+R key combination to 
open the command prompt. Then enter "devmgmt.msc" and confirm with the 
Enter key or by clicking the "OK" button.

fig. 6.4.1 - "Execute" dialogue box
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The device appears in the Device Manager under the "Ports (COM & LPT)" tab as 
"USB-SERIAL CH340 (COMX)", where X is replaced by the corresponding port number.

fig. 6.4.2 - View in Windows Device Manager

6.5. The Arduino IDE
6.5.1. Choosing the right board

To be able to load the sample code onto your controller, it is necessary to 
specify the board in the IDE with the corresponding serial port (COMX). The 
COM port is only displayed after the board has been connected. Accept all 
settings as shown in the screenshot:

fig. 6.5.1 Selecting the appropriate board with the corresponding port
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6.5.2. Programming process and language reference

The "Arduino programming language is closely related to C and C++. A 
complete overview and explanation in German can be found directly on the 
Arduino website under the following link: 
https://www.arduino.cc/reference/de/

In order to be able to programme the board, there are many examples 
already included. You can find these directly in the development 
environment under File -> Examples. There are also examples specifically for 
boards with an ESP8266 processor.

fig. 6.5.2.1 Supplied examples for the board with ESP8266

To start the programming process, connect your controller to the PC, select 
the correct board definitions and the relevant COM port. Then click on the 
"Upload" button to compile the programme code with all the necessary 
libraries and transfer it to the controller via the serial connection (COM 
port):

https://www.arduino.cc/reference/de/
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fig. 6.5.2.2 Starting the compilation and transfer process of the code to the controller

6.5.3. Arduino core for ESP

The language reference mentioned in chapter 6.5.2 can be used without any 
significant restrictions. However, a large number of functions have been 
added for boards with an ESP processor that cannot be found in the Arduino 
documentation. An up-to-date version of the Arduino Core documentation 
for boards with an ESP processor can be accessed at any time via the 
following link:

https://arduino-esp8266.readthedocs.io/en/latest/

https://arduino-esp8266.readthedocs.io/en/latest/
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7. Handling the pins of the D1 mini V4
7.1 Digital I/O pins

Just like the Arduino, the D1 Mini V4 has digital input/output pins or GPIO - 
General Purpose Input/Output Pins. As the name suggests, they can be used as 
digital inputs to read a digital voltage, or as digital outputs to output either 0V 
(LOW) or 3.3V (HIGH). The D1 Mini V4 has a microcontroller that works with a 
voltage range of 0V-3.3V.
The maximum voltage that can be drawn from a GPIO pin is 12mA!
Note: The pins are not 5V-tolerant, applying more than 3.6V PER PIN will destroy 
the chip!
GPIO1 and GPIO3 are used as TX and RX of the serial interface (UART), so in most 
cases they cannot b e  used as normal I/O when sending/receiving serial data. The 
D1 Mini
V4 module has an integrated LED that is connected to the GPIO2 pin.

7.2 PWM
Unlike most Atmel chips (Arduino), the D1 Mini module does not support hardware 
PWM, but software PWM is supported on all digital pins. The default PWM range is 
10 bits at 1kHz, but this can be changed (up to >14 bits at 1kHz).

7.3 Analogue input
The D1 Mini V4 module has an analogue input with an input range of 0V-3.0V. If 
more is supplied, this could damage the chip. The ADC (analogue-to-digital 
converter) has a resolution of 10 bits.

7.4 Serial
The D1 Mini module has two hardware UARTS (serial interfaces): UART0 on pins 1 
and 3 (TX0 and RX0 respectively) and UART1 on pins 2 and 8 (TX1 and RX1 
respectively), but GPIO8 is used to connect the flash chip. This means that UART1 
can only transmit data. In most cases, one UART port is more than sufficient.
UART0 also has a hardware flow control on pins 15 and 13 (RTS0 and CTS0 
respectively). These two pins can also be used alternatively as TX0 and RX0 pins.

7.5 I2C
The D1 Mini Module V4 does not have a hardware TWI (Two Wire Interface), but is 
implemented in software. This means that you can use pretty much any two
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digital pins can be used. By default, the I²C library uses pin 4 as SDA and pin 5 as SCL. 
(The data sheet specifies GPIO2 as SDA and GPIO14 as SCL) The maximum speed is 
about 450kHz.

7.6 SPI
The D1 Mini Module V4 has an SPI connection that is available to the user and is 
referred to as HSPI. It can be used in both slave and master mode (in software!).
It uses:
- GPIO14 as clock - CLK,
- GPIO12 as MISO,
- GPIO13 as MOSI and
- GPIO15 as slave select - SS.

8. Using the pins in the Arduino IDE

8.1. Digital IO pins

Just as with a normal Arduino board, the pin function can be set with the following 
line of code:

pinMode(pin, mode)

where "pin" is the name of the GPIO pin and the mode can be either INPUT (which is 
the default) or OUTPUT or INPUT_PULLUP to e n a b l e  the inbuilt pull-up 
resistors for pins GPIO0-15. To enable the pull-down resistor for GPIO16, use 
INPUT_PULLDOWN_16.

To set an output pin to HIGH (3.3V) or LOW (0V), use the following line of code:

digitalWrite(pin, value)

where pin is the name of the GPIO pin and the value is either 1 or 0 (or HIGH and 
LOW).

To read an input, use the following line of code:

digitalRead(pin)

To activate PWM on a specific pin, use the following line of code:

analogWrite(pin, value)
where pin is the name of the GPIO pin and the value is a number between 0 and 
1023.
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The range of the PWM output can be changed using the following line of code:

analogWriteRange(new_range)

The frequency of the PWM can be changed using the following line of code:

analogWriteFreq(new_frequency)
where new_frequency should be between 100Hz and 1000Hz.

9. Flashing the firmware
9.1. Preparation

The module is supplied with AT firmware already installed. If you have overwritten 
the firmware with your own sketch or third-party firmware, you can restore the 
module to its factory settings. To do this, the firmware must be downloaded from 
the chip manufacturer and transferred to the module using a  PC with special 
software. The following packages must be downloaded for this:

● the "Espressif NON-OS SDK" from the official GitHub page ("Clone or 
Download" and then "Download ZIP"): 
https://github.com/espressif/ESP8266_NONOS_SDK/tre 
e/release/v2.2.x

● the "NodeMCU Flasher" tool from
https://github.com/nodemcu/nodemcu-flasher (depending 
on platform WIN32/Release or Win64/Release)

9.2. The required .bin files
Since version 2.1.0, the firmware is divided into 4 files with the extension .bin. The 
following files from the .ZIP file are required for the D1 mini:

● bin/boot_v1.7.bin
● bin/at/512+512/user1.1024.new.2.bin (4MB Flash = 32 Mbit, 512+512)
● bin/esp_init_data_default_v08.bin
● bin/blank.bin

9.3. NodeMCU Flasher
After starting the software, the following window appears:

https://github.com/espressif/ESP8266_NONOS_SDK/tree/release/v2.2.x
https://github.com/espressif/ESP8266_NONOS_SDK/tree/release/v2.2.x
https://github.com/nodemcu/nodemcu-flasher
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fig. 7.3.1 - Programme interface of the NodeMCU Flasher

As "COM Port" we select the COM port to which the module is connected.

The "Config" tab takes you to the configuration page where you can specify the 
desired files and the offset in the memory. The following settings must be made 
here:

File from the firmware SDK Flash Offset

bin\boot_v1.7.bin 0x00000

bin\at\512+512\user1.1024.new.2.bin 0x01000

bin\esp_init_data_default_v08.bin 0x7C000

bin\blank.bin 0x7E000
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fig. 7.3.2 -Configuration of the NodeMCU Flasher

Make sure that the entries to be transferred are marked with an "X" on the left-hand 
side.

To start the flash process, switch to the "Operation" tab and select the "Flash" 
button. The programme overwrites the module's flash memory with the selected 
files without prompting you.
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fig. 7.3.3 -Flashing process in the NodeMCU Flasher

Once the flash process is complete, the module can be communicated with via the 
serial interface using AT commands. To do this, the baud rate must be set to 115200 
baud.

fig. 7.3.4 -Communication using AT command via terminal programme
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10. Error table
Malfunction Possible cause Troubleshooting

Check voltage sourceMissing power supply

Check USB cable

No function (the 
LED does not light 
up briefly when 
connected to the 
power source)

Module defect Contact customer 
service

No connection with PC Connect the module 
to your PC

Check driver installation Reinstall 
driver

USB cable Please only use 
certified USB2.0 
cables

COM port is not 
available

Module defect Contact customer 
service

Wrong COM port selected Select the correct 
COM port as shown 
in fig. 6.5.1

Wrong board selection Check board 
information as shown 
in fig.
6.5.1 mapped

USB cable Please only use 
certified USB2.0 
cables

Firmware defect Restoration of the 
delivery status as 
described in chapter 
7

Programming process 
not possible

Module defect Contact customer 
service

exit status 1 expected ';'Code cannot be 
compiled

exit status 1 missing termination

Please check your 
programme code
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exit status 1 No such file or dir Integrate library

11. Waste disposal
Do not dispose of with household waste! Your microcontroller must be disposed of in an 
environmentally friendly manner in accordance with the European Directive 2012/19/EC on 
waste electrical and electronic equipment. The valuable raw materials it contains can then 
be recycled. The application of this directive contributes to environmental and health 
protection. Use the collection centre set up by your local authority to return and recycle old 
electrical and electronic equipment. WEEE reg. no.: DE 62624346

12. Guarantee and warranty
The statutory warranty regulations apply unless otherwise agreed in our GTC. You can find 
the GTC on our website at:

http://www.az-delivery.de/pages/agb

as well as in Appendix I of this documentation. The version of the General Terms and 
Conditions in force at the time of conclusion of the contract between the Buyer and AZ-
Delivery Vertriebs GmbH shall apply.

http://www.az-delivery.de/pages/agb
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13. Licence information
13.1. Arduino core

Arduino IDE is developed and maintained by the Arduino team. The IDE is 
licensed under GPL.

ESP8266 core includes an xtensa gcc toolchain, which is also under GPL.

Esptool written by Christian Klippel is licensed under GPLv2, currently 
maintained by Ivan Grokhotkov: https://github.com/igrr/esptool-ck.

Espressif SDK included in this build is under Espressif MIT Licence. 

ESP8266 core files are licensed under LGPL.

SPI Flash File System (SPIFFS) written by Peter Andersson is used in this 
project. It is distributed under the MIT licence.

umm_malloc memory management library written by Ralph Hempel is used 
in this project. It is distributed under the MIT licence.

SoftwareSerial library and examples written by Peter Lerup. Distributed under 
LGPL 2.1.

axTLS library written by Cameron Rich, built from 
https://github.com/igrr/axtls-8266, is used in this project. It is distributed 
under BSD licence.

BearSSL library written by Thomas Pornin, built from 
https://github.com/earlephilhower/bearssl-esp8266, is used in this project. It 
is distributed under the MIT Licence.

LittleFS library written by ARM Limited and released under the BSD 3-clause 
licence.

13.2. Espressif firmware
The MIT Licence (MIT)

Copyright (c) 2014 zeroday nodemcu.com

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, 
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions:

https://github.com/igrr/esptool-ck
https://github.com/pellepl/spiffs
https://github.com/rhempel/umm_malloc
https://github.com/plerup/espsoftwareserial
http://axtls.sourceforge.net/
https://github.com/igrr/axtls-8266/blob/master/LICENSE
https://bearssl.org/
https://bearssl.org/#legal-details
https://github.com/ARMmbed/littlefs
https://github.com/ARMmbed/littlefs/blob/master/LICENSE.md
https://github.com/ARMmbed/littlefs/blob/master/LICENSE.md
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The above copyright notice and this permission notice shall be included in all copies 
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

13.3. Espressif ESP8266_NONOS_SDK
ESPRESSIF WITH licence

Copyright (c) 2015 <ESPRESSIF SYSTEMS (SHANGHAI) PTE LTD>

Permission is hereby granted for use on ESPRESSIF SYSTEMS ESP8266 only, in which 
case, it is free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without 
restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following 
conditions:

The above copyright notice and this permission notice shall be included in all copies 
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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Appendix I - General Terms and Conditions
1. Scope of application

The following terms and conditions apply to all orders placed via our online shop by 
consumers and entrepreneurs.

A consumer is any natural person who enters into a legal transaction for purposes 
that are predominantly outside their trade, business or profession. An entrepreneur 
is a natural or legal person or a partnership with legal capacity who, when concluding 
a legal transaction, is acting in the exercise of their commercial or independent 
professional activity.

These General Terms and Conditions shall also apply to future business relationships 
with entrepreneurs without us having to refer to them again. If the entrepreneur 
uses conflicting or supplementary general terms and conditions, their validity is 
hereby rejected; they shall only become part of the contract if we have expressly 
agreed to them.

2. Contractual partner, Conclusion of contract

The purchase contract is concluded with AZ-Delivery Vertriebs GmbH.

The presentation of the products in the online shop does not constitute a legally 
binding offer, but a non-binding online catalogue. You can initially place our products 
in the shopping basket without obligation and correct your entries at any time 
before sending your binding order by using the correction aids provided and 
explained for this purpose in the order process. By clicking on the order button, you 
place a binding order for the goods contained in the shopping basket. Confirmation 
of receipt of your order will be sent by e-mail immediately after the order has been 
sent.

When the contract with us is concluded depends on the payment method you have 
chosen:

Invoice

We accept your order by sending a declaration of acceptance in a separate e-mail or 
by delivering the goods within two days.
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Credit card

When you place your order, you also send us your credit card details. After you have 
been legitimised as the legal cardholder, we will ask your credit card company to 
initiate the payment transaction and thereby accept your offer.

PayPal Express

During the ordering process, you will be redirected to the website of the online 
provider PayPal. There you can enter your payment details and confirm the payment 
instruction to PayPal. After placing the order in the shop, we request PayPal to 
initiate the payment transaction and thereby accept your offer.

Immediately

After placing the order, you will be redirected to the website of the online provider 
Sofort GmbH, where you confirm the payment instruction. This concludes the 
contract with us.

Cash payment on collection

We will accept your order by sending a separate e-mail declaration of acceptance 
within two days.

Payment by SEPA direct debit

The buyer can issue AZ-Delivery Vertriebs GmbH with a SEPA basic mandate. The 
period for pre-notification shall be reduced to one day. The Buyer warrants to ensure 
that the account is covered. Costs incurred due to non-payment or reversal of the 
direct debit shall be borne by the Buyer, provided that the non-payment or reversal 
was not caused b y  AZ-Delivery Vertriebs GmbH.

3. Contract language, Contract text storage

The languages available for the conclusion of the contract are German and English.

We save the text of the contract and send you the order data and our GTC by e-mail. 
For security reasons, the text of the contract is no longer accessible via the Internet.
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74. Terms of delivery

Shipping costs are added to the indicated product prices. You can find out more 
about the shipping costs in the offers.

In principle, you have the option of collecting the goods from AZ-Delivery Vertriebs 
GmbH, Plattlinger Straße 5 , 94469 Deggendorf, Germany during the following 
business hours: 8:00-18:00 (Mon-Sat).

5. Payment

The following payment methods are available in our shop:

Credit card

When you place your order, you also send us your credit card details.

Once you have been legitimised as the legitimate cardholder, we will ask your credit 
card company to initiate the payment transaction immediately after you place the 
order. The payment transaction will be carried out automatically by the credit card 
company and your card will be debited.

PayPal Express

During the ordering process, you will be redirected to the website of the online 
provider PayPal. In order to be able to pay the invoice amount via PayPal, you must 
be registered there or register first, legitimise yourself with your access data and 
confirm the payment instruction to us. After placing the order in the shop, we 
request PayPal to initiate the payment transaction.

Immediately

After placing the order, you will be redirected to the website of the online provider 
Sofort GmbH. In order to be able to pay the invoice amount via Sofort, you must 
have an online banking account with PIN/TAN procedure activated for participation 
in Sofort, legitimise yourself accordingly and confirm the payment instruction to us. 
You will receive further instructions during the order process. The payment 
transaction will be carried out immediately afterwards by Sofort and your account 
will be debited.
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Invoice

You pay the invoice amount after receipt of the goods and the invoice by bank 
transfer to our bank account. We reserve the right to offer purchase on account only 
after a successful credit check.

Cash payment on collection

You pay the invoice amount in cash on collection.

6. Retention of title

The goods remain our property until full payment has been received.

For entrepreneurs, the following also applies: We reserve title to the goods until all 
claims arising from an ongoing business relationship have been settled in full. You 
may resell the goods subject to retention of title in the ordinary course of business; 
you assign to us in advance all claims arising from this resale - irrespective of any 
combination or mixing of the goods subject to retention of title with a new item - in 
the amount of the invoice amount, and we accept this assignment. You remain 
authorised to collect the claims, but we may also collect claims ourselves if you do 
not meet your payment obligations.

7. Transport damage

The following applies to consumers:

If goods are delivered with obvious transport damage,  please complain about such 
defects to the deliverer as soon as possible and contact us immediately. Failure to 
make a complaint or contact us has no consequences for your legal claims and their 
enforcement, in particular your warranty rights. However, you will help us to assert 
our own claims against the carrier or the transport insurance company.

The following applies to entrepreneurs:

The risk of accidental loss and accidental deterioration shall pass to you as soon as 
we have delivered the goods to the carrier, freight forwarder or other person or 
organisation designated to carry out the shipment. The obligation to inspect and give 
notice of defects regulated in § 377 HGB applies to merchants. If you fail to notify us 
as stipulated therein, the goods shall be deemed to have been approved unless the 
defect was not recognisable during the inspection. This shall not apply if we have 
fraudulently concealed a defect.
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8. Warranty rights and Liability

Unless otherwise stated in these GTC including the following provisions, we shall be 
liable in the event of a breach of contractual and non-contractual obligations in 
accordance with the statutory provisions.

We shall be liable for damages - irrespective of the legal grounds - within the scope 
of fault-based liability in the event of wilful intent and gross negligence. In the event 
of simple negligence, we shall only be liable, subject to statutory limitations of 
liability (e.g. care in our own affairs; insignificant breach of duty), for

A. for damages resulting from injury to life, limb or health,
B. for damages arising from the breach of an essential contractual obligation (an 

obligation whose fulfilment is essential for the proper execution of the contract and 
on whose compliance the contractual partner regularly relies and may rely); in this 
case, however, our liability is limited to compensation for foreseeable, typically 
occurring damages.

The limitations of liability set out above shall also apply to breaches of duty by or in 
favour of persons whose fault we are responsible for in accordance with statutory 
provisions. They shall not apply if we have fraudulently concealed a defect or have 
assumed a guarantee for the quality of the goods and for claims under the Product 
Liability Act.

9. Dispute resolution

The European Commission provides a platform for online dispute resolution (OS), 
which you can find here https://ec.europa.eu/consumers/odr/.

We are not obliged or willing to participate in dispute resolution proceedings before 
a consumer arbitration board.

10. Final provisions

If you are an entrepreneur, German law shall apply to the exclusion of the UN 
Convention on Contracts for the International Sale of Goods.

If you are a merchant within the meaning of the German Commercial Code, a legal 
entity under public law or a special fund under public law, the exclusive place of 
jurisdiction for all disputes arising from contractual relationships between us and you 
is our registered office.
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Terms and conditions created with the Trusted Shops legal text editor in co-operation 
with Wilde Beuger Solmecke Rechtsanwälte.

Please note that we use the following licences, among others, to create our website: 
Licencing

http://shop.trustedshops.com/rechtstexte-kostenlos
https://shop.trustedshops.com/de/
http://www.wbs-law.de/
https://www.az-delivery.de/pages/licensing
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Appendix II - Contact details

AZ-Delivery Vertriebs GmbH
Bräugasse 9
94469 Deggendorf 
Germany

Phone: +49 991 999 27 8 27
Email: info@az-delivery.com

mailto:info@az-delivery.com

